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Index of Command Functions

Command description [keyboard shortcut]:description including special instructions.

Keyboard short for a Windows PC: the Control key AND the shortcut key.

For a MacIntosh: the Meta or Command (Apple symbol) key AND a shortcut key.

Note: lower case characters only!

Under the MicroObservatoryImage menu (Mac OSX version only):

1. About MicroObservatoryImage: Program information, including program

release version, contact information and Internet address for the software program

and instructions. A toggle button allows the user to check for the most current

version of the MicroObservatoryImage program.

2. Services: Not applicable.

3. Hide MicroObservatoryImage [Meta h]: Minimize the program.

4. Hide Others [Option Meta h]: Minimize all other programs.

5. Quit [Meta q] : Quit the program and closes all images. Note: The program will

prompt you to save all open, unsaved images BEFORE quitting the program.

Under the File menu:



1. Open an image on local disk… [Meta o] : Open an image file from your local

computer. The program only opens FITS and GIF formatted image files. The

‘Drag and Drop’ feature allows you to drag an image, a file, or a URL address

onto MicroObservatoryImage icon (Mac OSX version only) or into the

application window (all versions) to open each.

2. Open an image on the Internet… [n/a] : Open an image file directly from the

Internet. Type or copy an URL address [copy to clipboard (Mac) or shortcut (PC)

and then paste with Meta v or click on the Paste button] and click the OK button.

The ‘Drag and Drop’ feature allows you to drag an image, a file, or a URL

address onto MicroObservatory Image icon (Mac OSX version only) or into the

application window (all versions) to open each.

3. Open MicroObservatory Image Directory [n/a] : The Image Directory on the

MicroObservatory web page is opened via your default internet web browser.

Follow directions above to open an image file in the program.

4. Close [Meta w] : Close current image.

5. Save As / GIF… : Save an image file in GIF  format (graphics interchange

format, a 256-brightness levels or 8-bit format). This data format may be gray

scale or composite color image. Remember to type the .GIF postfix to the end of

each file name created.

Save As / FITS… : Save an image file in FITS format (flexible image transport

system, the standard data format used in astronomy, which has basically an

unlimited data size, but this program can manipulate signed 32-bit images or over

4 billion color/gray shades). Note: The original FITS header information is saved

with the image, even if you have changed the image in anyway. Remember to

type the .FITS postfix to the end of each file name.

Note: MicroObservatory images originally come from a 12-bit digital imaging

device but they are stored using the 16-bit FITS data format standard.  12-bit

means there are 4096 brightness levels or shades of gray between black and white.

Black has a value of 0 and white equals 4095.

Save As / Animated GIF… : Save an image file in GIF format, similar to above

but this contains several images in sequence which display as an animation.

Note: only a Stacked image can be saved as an animated GIF, which is created

from Process / Stack / Convert Images to Stack command. Remember to type the

.GIF postfix to each file name.

6. Print [Meta p] : Print the current image.



Under the Edit menu:

(Note: all these commands are for text functions, NOT for image processing steps,

except the Undo function.)

1. Undo [Meta z] : Undo last command performed. Works on Adjust Image, Color

Table, Sharpen, Reduce Noise functions.

2. Cut [Meta x] : Highlight text with mouse then cuts or remove text. Cut text is

saved in memory.

3. Copy [Meta c] : Highlight text with mouse then makes a copy without removing

text. Copied text is saved in memory.

4. Paste [Meta v] : Text saved in memory from Cut or Copy command is pasted

where the mouse cursor is located.

5. Select All [Meta a] : All text in current window is highlighted.

Under the Process menu:

1. Adjust Image [n/a] : Rescales or remaps the brightness values of each picture

element (pixel) of the displayed image to a different range of brightness values.

A new window pops up with the title ‘Adjust Image’. You may choose either

Linear (the default) or Log to scale the image values by clicking on the

appropriate button. The maximum and minimum values of the image are initially

displayed (as the default values) showing the full range of values. You may want

to adjust the displayed range of brightness values to see detail not seen. You may

adjust the maximum and minimum values either by clicking, holding and sliding

the arrows to the right of the scale or by typing an integer value into the respective

boxes on top and bottom. The Auto button automatically rescales the image with



the optimized linear or logarithmic scaling method, depending on which button is

chosen.

Auto-Linear scaling sets the minimum and maximum values at two standard

deviations from the mean pixel brightness value, then scaling 4095 brightness

values between these established min-max values. Auto-Log scaling sets the

minimum at the mode value and the maximum at five standard deviations then

stretches the contrast scale logarithmically between these values to emphasize

small changes in brightness near the mode (the most common pixel brightness

value) while deemphasizing the brightest pixel values image components.

The Reset button returns the image to the default full-scale linear minimum and

maximum display values.

Linear rescaling is best for displaying bright objects like the Moon and planets.

Logarithmic rescaling optimizes faint detailed features in nebulae and galaxies

while still seeing the brighter details in the image.

2. Color Tables / various color options [n/a] : The image can be ‘colorized’,

meaning that for each individual brightness level a specific color can be assigned

to that value. The default ‘color table’ is a gray scale where the smallest or

faintest value is black and the highest or brightest value is white, with

intermediate values being lighter shades of gray as pixel values increase. Matched

the color table for filtered image is useful in creating RGB color imagery. See

Stack command.

Color Tables / Gray Scale: Different shades of gray represent pixel

  brightness values, black being faintest and white being the brightest.

Color Tables / Red: Light red colors are bright high values, and darker

  red to black are low dimmer values. Use for red filtered images to create

  full color images.



Color Tables / Green: Light green colors are bright high values, and

  darker green to black low dimmer values. Use for green filtered images

  to create full color images.

Color Tables / Blue: Light blue colors are bright high values, and darker

  blue to black low dimmer values. Use for blue filtered images to create

  full color images.

Color Tables / Spectrum: A multicolor (rainbow) table, where violet and

  blue are brighter pixel values and yellow to red are dimmer values.

  This table helps viewing low contrast images.

Color Tables / Fire: A different multicolor table. Brighter pixel values are

  yellow to red and fainter values are violet to blue.

Color Tables / Ice: Another multicolor table, the reverse of Fire. Brighter

  pixel values are red to pink and fainter values are blue to green.

Note: the brightness values for pixel in the image DO NOT change, only how

they are represented or viewed on the display.

3. Invert Color [n/a] : Invert the brightness values of the images, converting the

brightest high value to the lowest and the faintest value to the highest, and doing

the same to all the intermediate values, to create a negative image of the original.

4. Sharpen [n/a] : Sharpen is a processing function that increases the brightness

difference for a pixel as compared the all the surrounding pixels. This function

increases the contrast, detail and noise of an image.

Warning: The actual image data is changed with this function, unlike other

functions in which the data is just displayed differently.

5. Reduce Noise [n/a] : Reduce noise is a function that averages a pixel’s value with

the surrounding pixels. This function reduces the noise viewed in an image but

also reduces the detail or blurs the image, which can also reduce the contrast. This

function is also called smoothing. Note: This function does not remove cosmic

ray events but rather hides them in the background.

Warning: The actual image data is changed with this function, unlike other

functions in which the data is just displayed differently.

6. Crop [n/a] : Takes a portion of the image as highlighted by the box tool and

creates a new image file. To use, open an image, select the box tool (located in the

upper left corner of the image window), click and drag the mouse to create a box

of the appropriate size and unclick. The box can be moved about the image by

clicking and holding the mouse cursor inside the shape and repositioning the

shape, unclicking the mouse to fix its position on the original image. Then choose

crop and a new image of the highlighted region is created in a different window.

7. Measure [Meta m] : Measures the pixel statistics for all the pixels highlighted by

the box or circle tools. Select the area of the image to be measured by choosing

the box or circle tool (located in the upper left corner of the image), click and drag

the mouse to create a box or circle of the appropriate size and unclick. The box or

circle can be moved about the image by clicking and holding the mouse cursor

inside the shape and repositioning the shape, unclicking the mouse to fix its

position. The shape can also be positioned with precision by pressing the ‘i’, ‘j’,

‘k’, and ‘l’ keyboard keys, which moves the box or circle pixel by pixel.

Then choose Measure. A new window displaying a table of statistical values of

the highlighted area is created. The first column of the table is the name of the

highlighted area, which you can rename by clicking within that cell and typing a



new name. The next columns display the area enclosed by the shape tool, mean

value of all the pixels, total value of all the pixels, the minimum and maximum

value found in all the pixels, as highlighted in the area. The contents of the table

can be copied, either each row (click on the row) or all and successive rows (click

AND also hold the Shift key, drag the cursor across the rows) or separate rows

(click AND hold the Control key, then individually select each row of interest).

Once selected, go to the Edit submenu and choose Copy. You can then paste the

statistical values into any other text editing or spreadsheet program.

8. Image Calculator… [n/a] : Performs arithmetic functions between two images.

Select this command and a new window labeled Image Calculator is displayed.

The most current image viewed is showed in both image registers. Only images

currently open are listed in pull-down image registers. Select which image as

Image 1, then either the add, subtract, multiply, divide function, and finally which

image as Image 2. By default, a new image window is created by the operation.

You must have more than one image frame open! Both images must have the

same dimensions (width, height and bit depth).

Add: Image1 is added to Image2 (Image1 + Image2).

Subtract: Image2 is subtracted from Image 1 (Image1 – Image2).

Multiply: Image1 is multiplied by Image2 (Image1 x Image2).

Divide: Image1 is divided by Image2 (Image1 / Image2).

Useful for subtracting ‘dark’ image frames from your image data.

Experiment with the calculator. You might be surprised at the results from a

simple calculation. The calculator performs only integer arithmetic and rounds

values up or down to the nearest integer. The resultant values must remain within

the range of values, 0 to 255 for 8-bit images and 0 to 4095 for 12-bit images.

Overflowing or underflowing this range may produce severe rounding of pixel

values and some very troublesome results. For example: Subtracting a high pixel

value from a low pixel value will result in a zero value, not a negative value.

Multiplying one image by another image can overflow the pixel value range,

producing strange results.



Caution: You cannot divide by zero! If you wish to divide one image by another

image that has a zero pixel value, add 1 to the image with the zero pixel value by

using the Math command.

9. Math [n/a] : Performs image arithmetic functions with integers to a single image.

Similar to the Image Calculator in function but instead of an image operating on

another image, an image is operated on by a constant value. The current image

highlighted will be operated upon. Select command and a new window labeled as

the arithmetic function (Add, Subtract, Multiply, Divide) is displayed. Type in an

integer value and click OK. By default, a new image window is created by the

operation.

Math / Add: An integer is added to the image.

Math / Subtract: An integer is subtracted from the image.

Math / Multiple: The image is multiplied by an integer.

Math / Divide: The image is divided by an integer.

Experiment with the arithmetic functions. Simple calculations are not always

simple. The calculator performs only integer arithmetic and rounds values up or

down to the nearest integer. The resultant values must remain within the range of

values, 0 to 255 for 8-bit images and 0 to 4095 for 12-bit images, etc.

Overflowing or underflowing this range may produce severe rounding of pixel

values. For example: Subtracting a high pixel value from a low pixel value will

result in a zero value, not a negative value. Multiplying an image by a high value

can produce an overflowed high value.

Caution: You cannot divide by zero!

10. Shift… [n/a] : Aligns one image with another. Select this command and a new

window opens, displaying a background and foreground pulldown image register,

magnification pulldown selection menu and a display window with two views, an

unmagnified and the magnified view of the images selected. Choose one image as

the background (preferably the image with brighter objects, such as the red

filtered image) and another image as the foreground. Only those images currently

opened in the program are listed in the pulldown image registers. You need at

least two images open to use this function. In the Shift display window, the

unmagnified image is seen on the left and the magnified view is seen on the right.

Magnification range is between 1 to 8 times the unmagnified view and is showed

in the small window in the upper right corner. The magnified view is a portion of

the unmagnified left image centered on the cursor position, as indicated by a

crosshair cursor. You can use both the mouse for large position shifts (click and

hold then release) and arrow keys on the keyboard for precise pixel by pixel

movements (Meta up, Meta down, Meta left and Meta right arrows) to move the

foreground image over the background image.

Useful for creating RGB full color images from individual filtered images, or

making an animated GIF movie, or adding several images together to create a

longer exposed image. Refer to the Stack command.



Use the unmagnified view and mouse to approximately fit the two images

together, then use the magnified view and arrow keys for fine alignment.

You may want to initially begin with a lower magnification and then select

progressively higher magnified views for more precise alignment. Once alignment

is accomplished, click OK. The foreground image is repositioned using the

background image coordinates. This command may be used with both GIF and

FITS images, including aligning a GIF with a FITS image. Note: Any pixels from

the foreground image that are not within the background image boundary are

permanently lost. Conversely, due to the shifting operation, new area is created on

the foreground image that was not there previously. This new area assumes a

similar background pixel value (the mode) from the original foreground image but

note that fake stars are not created! Experiment, because the process takes some

practice. Note as to what part of the shifted foreground image is real and what is

fake. Caution: Always save the new shifted image with a different file name than

the origin. Best to use a copy of the origin data in any procedure that alters the

data!

11. Stack [n/a] : Compiles of several images into one image to either create color

RGB imagery or animations or a ‘longer exposure’. All the images to be stacked

must be the same format, either all GIF or all FITS and have the same width,

height and bit depth. Click on the image frame of interest; next choose Add Slice



to begin creating a stack. The image display changes, with a new window title

labeled Stack, with a numerical counter at the bottom with forward and reverse

directional arrows for sorting the slices. This numerical counter shows how many

slices are in the stack. Continue adding slices until all the requested images are

included. To remove an image, click the forward or reverse arrows at the bottom

of the frame until the unwanted image is displayed, then select Delete Slice.

Program functions can still operate on each individual slice within the Stack, such

as Shift, Color, Crop, etc. even all the Tool Bar utilities, with the exception of

the Process/Image Calculator and the Window/FITS Header functions.

Stack / Add Slice: Add current active image frame to Stack.

Stack / Delete Slice: Delete the displayed, specific image slice from Stack.

Stack / Convert Images to Stack: Automatically add all open images within

the program onto a Stack.  Each image is added to the stack by order of most

recent frame viewed to last frame viewed. Every image must have the same

dimensions and bit depth.

Stack / Convert Stack to Images: Automatically remove every slice from the

Stack, creating a new image for each slice within the Stack. Data format is

preserved from the original image when ‘unstacked’.

Stack / Convert Stack to RGB: Convert three separate, colored images into a

composite RGB color image. Begin procedure by adding only three images to



a stack. Select red, green or blue (by the Color Tables command) for each

slice in stack (choose image frame by arrows at frame bottom). Each image

may be colorized before adding the images to the stack also. Either method

works. There must be only one red colored slice, one green slice and one blue

slice in the stack or an error is displayed. Finally, choose the Convert Stack to

RGB command. Note: This command converts all image formats to a 8-bit

depth format, which can not be reversed. Higher bit depth image information

will be lost permanently.

Stack / Convert RGB to Stack: Converts a single RGB color image into

three separate image slices within a Stack, one slice each of a red, green, blue

color. If you unstuck the slices, each resulting image would be an 8-bit GIF

formatted image.

Stack / Start Animation: Begin animation sequence of stacked images.

Review sequence prior to saving the image stack.

Stack / Stop Animation: End animation sequence of stacked images.

Stack / Animations Options…: Set rate each frame in stack is displayed

during animation sequence. Command shows a window entitled Stack

Animation Settings and box where the frame rate, in frames per second (fps)

can be adjusted. The slowest rate may be set to 1 fps and the fastest at 24 fps.

Remember to save the converted RGB stack to GIF image as a GIF image by the

command File / Save As / Gif… . Use the command File / Save As / Animated

GIF… to save the stack as an animation file. Note, once a stack is saved as an

animated GIF formatted file, the frame rate cannot be altered.

Under the Window menu:

1. Image Info [Meta I] : Displays basic information on the FITS or GIF image and

provides a zoomed (magnified) view of the current cursor location, indicated by a

red crosshair. When the user starts the program, the Image Info window is opened

in the top right of the program by default. Instructions stating “Place Cursor Over

Image, Use Up and Down Arrows to Zoom in and out of Image” are shown to

explain how image information can be viewed and is only displayed when the

cursor is not positioned over an image.  The image information shown:

Data: 8 or 16-bit grayscale or color data image format standard.

Image window name is displayed, if a Stack.

Size: ‘XX’ x ‘YY’ (horizontal by vertical) numerical dimensions in pixels

of the image. The origin (at the 0,0 position) is located in the upper left

corner of the image.

Window Mag: Magnification factor of the active image window. There

are 1 to 16 levels of magnification centered on the present cursor position.

Level 1 has no magnification and 16 the highest zoom factor. Refer to the

Magnification Tool description in the Tool Bar section for more

information about this feature.

Image Info Mag: Magnification factor of smaller zoomed portion of

active window shown in Image Info display window. There are 1 to 7

levels of zoom (magnification) available, centered on the cursor position.

Level 1 is the lowest zoom factor and 7 the highest.



Level 1 = 100 x100 square array (no magnification)

Level 2 = 50x50 square array

Level 3 = 32x32 square array

Level 4 = 24x24 square array

Level 5 = 20x20 square array

Level 6 = 16x16 square array

Level 7 = 14x14 square array

Cursor position and pixel value: X, Y, brightness value. The X value is

the column or left to right position on the image. The Y value is the row or

top to bottom position on the image. The pixel brightness value is

measured brightness for the specific individual pixel the cursor is currently

pointing to.

To recall the Image Info window if closed, click on the command under the

Windows menu. If the window cannot be seen amongst numerous open windows,

click on the Image Info command, which will place the window in the uppermost

right of the application window.

2. FITS Header [Meta f] : Displays information from a FITS (flexible image

transport system) data file, called the FITS Header. Note: Edit menu functions



Select All and Copy can be used in this file window, to paste this data into

another application.

3. Intensity Histogram [n/a] : Graph of pixel brightness values for the image data.

The graph displays brightness level of pixels versus the number of pixels with that

particular brightness value. The graph automatically sets the faintest brightness

value on the left of the X-axis to the minimum pixel value found in the array and

the brightest value to the maximum pixel value. A grey-scale bar is displayed

below the X-axis to indicate darker to brighter scale of the represented values.

The Y-axis values are automatically set to zero (no pixel with this brightness

value) to the most frequent occurrence of a pixel brightness value in the image.

Below the graph is displayed statistics for the image, including the image data file

the histogram is calculated from, the minimum pixel brightness value, the

maximum brightness value, the mode (most frequent value occurring within the

image), the mean (average brightness value), the variance (the dispersion of

brightness values from the mean value), the standard deviation (the square root of

the variance) and the bin width (range of values). The variance can be used to

characterize the noise and other factors of the digital detector. The standard

deviation is another measure of noise characteristics. The bin width represents the

frequency of pixel brightness values within a range of brightness values for the

image data. This graph represents how many pixels within the image have those

values.

A histogram can be calculated for each image opened within the application, so

you can compare different image histograms.

4. Windows Open Utility [n/a]: All the open images and histograms within the

application are listed at the bottom of the Windows pull down menu. The active,

topmost window is listed first and each successive image/histogram there after.

Selecting any window from the list makes it the active, topmost window.



Under the Help menu:

1. About MicroObservatory Image… [n/a] : Program information, including

program release version, programmer contact and Internet address for the

program and instructions. A toggle button allows the user to check for the most

current version of the MicroObservatoryImage program.

Note: Memory recommended to run this program is 256MB.



The Tool Bar (in the upper left corner of every image window, below the file name):

1. Diagonal Line [n/a] : Measures separation between two points on the image.

Select the diagonal line icon at the top left of the image window. Click and hold

the mouse then drag and release at end point. To the right of the Tool Bar is

displayed the starting point in X,Y (horizontal, vertical) image pixel coordinates

and the length in pixels of the line. Remember the origin (or 0,0) position is the

upper left corner of the image. Note: Use the Image Info/Zoom Window or the

Magnification tool when selecting the beginning and ending point for  more

precise linear measures.

2. Box [n/a] : Measures the area enclosed by the scalable and moveable box. Select

the square box icon at the top left of the image window. Click and hold the mouse

then drag and release to define the box shape and size. Click and hold the mouse

button within the box, then drag and release at the preferred location moves the

box to a new location. Alternatively, for precise repositioning of the box, press the

‘i’, ‘j’, ‘k’, or ‘l’ keys on the keyboard to move the shape a pixel at a time. To the

right of the Tool Bar is shown the upper rightmost corner of the box in X,Y

(horizontal, vertical) pixel coordinates and the width and height of the box, also in

pixels. Remember the origin (or 0,0) position is the upper left corner of the image.

This tool is used to define the area of the image to crop or measure pixel values,

found under the Process menu. Note: Use of the Image Info/Zoom Window or

the Magnification tool when making more precise area measures.

3. Circle [n/a] : Measures the area define within the circumference of a scalable and

moveable circle. Select the circle icon at the top left of the image window. Click

and hold the mouse then drag and release to set the radius. Click and hold the

mouse button within the circle shape, then drag and release at the preferred

location to reposition the circle. Alternatively, for precise repositioning of the

circle, press the ‘i’, ‘j’, ‘k’, or ‘l’ keys on the keyboard to move the shape a pixel

at a time. To the right of the Tool Bar is shown the center of the circle in X,Y

(horizontal, vertical) pixel coordinates and the radius of the circle in pixels.

Remember the origin (or 0,0) position is the upper left corner of the image. Note:

Use of the Image Info/Zoom Window or the Magnification tool when making

precise area measures.

4. Magnification [n/a] : Full screen magnification utility. Select the magnifying

glass icon at the top left of the image window. Position the mouse button within

the image window and click to magnify the image window centered on this

location. Each successive mouse button click doubles the magnification for this

portion of the image, again, centered on where the mouse is clicked on the

displayed image. Maximum zoom level is 16 times magnification (level 16).

Click on the magnification icon in the Tool Bar to zoom in one magnification

level or double click to return to an unmagnified image (level 1).

5. The Letter A [n/a] : A text writing tool for GIF images only. The GIF image

must not be magnified. Select the letter ‘A’ icon in the Tool Bar at the top left of



the image window. Click and hold the mouse button then drag and release to

define the text box. Click and hold the mouse button within the defined text box,

then drag and release at the preferred location to reposition. Double clicking on

the letter A in the Tool Bar allows you to adjust the font, size, style and color of

the text. A sample text “Type Text Here” is shown. This text is deleted once one

starts typing in the text box. Only one font, size, style, etc. is permitted in the text

box. One space character is displayed between words, as multiple spaces do not

add additional spacing. A space character can start a new line. The carriage return

key is not available. The delete/back space key erases all mistakes. Long words

are automatically repositioned on a new line and will overfill the boundaries of

the defined text box if permitted. The text box can be resized but is of limited

functional use. Double click outside of the text box to set the location of the text

box on the image. Use the Edit menu command Undo to start over, if desired.

Note: Experiment with this tool before altering a final processed image.

Caution: Adding text will permanently alter the image, so save a copy of the

origin GIF image file.

6. The Pencil [n/a] : This tool allows free-hand drawing of a single line on the

image. Select the pencil icon at the top left of the image window.  Click and hold

the mouse to draw a line. To the right of the Tool Bar is the current location of the

mouse cursor. Double clicking on the Pencil in the Tool Bar allows you to adjust

the thickness and color of the line. The Edit command Undo will erase the last

completed line only. Experiment with this tool before altering the image.

Caution: Drawing lines on the image will permanently alter the image, so save a

copy of the origin GIF image file.

MicroObservatoryImage, version 2.1 can be selected as the default application to

open FITS and/or GIF image files in Mac OSX. Choose the image file (FITS or GIF

format) and select Get Info [Meta i]. A new window displaying the file information

appears. Select the MicroObservatoryImage application from the Open with: pull

down selection menu within the Get Info window.
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